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Thank you for purchasing the MATLAB tool kit for DL series (701991).

This User’'s Manual contains useful information about the precautions, functions, and
operating procedure of the MATLAB tool kit for DL series. To ensure correct use, please
read this manual thoroughly before beginning operation. For information about the
handling of the WVF File Access Tool Kit that is included in the package, prepare the
Model 707712 WVF File Access API or the Model 707741 WE Control API, and see
chapter 3 in this manual.

After reading the manual, keep it in a convenient location for quick reference whenever a
question arises during operation.

For information about the handling precautions, functions, and operating procedures of
Windows, MATLAB, and Yokogawa’s DL Series Oscilloscopes, see the respective
manuals.

» The contents of this manual are subject to change without prior notice as a result of
continuing improvements to the software’s performance and functions. The figures
given in this manual may differ from those that actually appear on your screen.

» Every effort has been made in the preparation of this manual to ensure the accuracy
of its contents. However, should you have any questions or find any errors, please
contact your nearest YOKOGAWA dealer as listed on the back cover of this manual.

« Copying or reproducing all or any part of the contents of this manual without the
permission of Yokogawa Electric Corporation is strictly prohibited.

» This software program supports the following DL Series Oscilloscopes.

DL1600 Series
DL1700E Series
DL7400 Series
DL750, and DL750P
DL9000 Series

* This manual supports MATLAB 7.0 sp2 (Release14) or later.

» The TCP/IP software of this product and the document concerning the TCP/IP
software have been developed/created by YOKOGAWA based on the BSD
Networking Software, Release 1 that has been licensed from the University of
California.

+ MATLAB is a registered trademark of The MathWorks, Inc. in the United States.

» Microsoft, MS-DOS, and Windows are either registered trademarks or trademarks of
Microsoft Corporation in the United States and/or other countries.

* Adobe and Acrobat are trademarks or registered trademarks of Adobe Systems
Incorporated.

» For purposes of this manual, the TM and ® symbols do not accompany their
respective trademark names or registered trademark names. Other company and
product names are trademarks or registered trademarks of their respective
companies.

» 1st Edition: July 2004

» 2nd Edition: September 2004
« 3rd Edition: October 2004

» 4th Edition: February 2006

All Rights Reserved, Copyright © 2004 Yokogawa Electric Corporation
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Terms and Conditions of the Software License

Yokogawa Electric Corporation, a Japanese corporation (hereinafter called “Yokogawa”), grants permission to use this Yokogawa Software
Program (hereinafter called the “Licensed Software”) to the Licensee on the conditions that the Licensee agrees to the terms and conditions
stipulated in Article 1 hereof.

You, as the Licensee (hereinafter called “Licensee”), shall agree to the following terms and conditions for the software license (hereinafter called
the “Agreement”) based on the use intended for the Licensed Software.

Please note that Yokogawa grants the Licensee permission to use the Licensed Software under the terms and conditions herein and in no event
shall Yokogawa intend to sell or transfer the Licensed Software to the Licensee.

Licensed Software Name: 701991 MATLAB Tool Kit for DL Series

Number of License: 1

Article 1 (Scope Covered by these Terms and Conditions)

1.1 The terms and conditions stipulated herein shall be applied to any Licensee who purchases the Licensed Software on the condition that the
Licensee consents to agree to the terms and conditions stipulated herein.

1.2 The “Licensed Software” herein shall mean and include all applicable programs and documentation, without limitation, all proprietary
technology, algorithms, and know-how such as a factor, invariant or process contained therein.

Article 2 (Grant of License)

2.1 Yokogawa grants the Licensee, for the purpose of single use, non-exclusive and non-transferable license of the Licensed Software with the
license fee separately agreed upon by both parties.

2.2 The Licensee is, unless otherwise agreed in writing by Yokogawa, not entitled to copy, change, sell, distribute, transfer, or sublicense the
Licensed Software.

2.3 The Licensed Software shall not be copied in whole or in part except for keeping one (1) copy for back-up purposes. The Licensee shall
secure or supervise the copy of the Licensed Software by the Licensee itself with great, strict, and due care.

2.4 In no event shall the Licensee dump, reverse assemble, reverse compile, or reverse engineer the Licensed Software so that the Licensee
may translate the Licensed Software into other programs or change it into a man-readable form from the source code of the Licensed
Software. Unless otherwise separately agreed by Yokogawa, Yokogawa shall not provide the Licensee the source code for the Licensed
Software.

2.5 The Licensed Software and its related documentation shall be the proprietary property or trade secret of Yokogawa or a third party which
grants Yokogawa the rights. In no event shall the Licensee be transferred, leased, sublicensed, or assigned any rights relating to the
Licensed Software.

2.6 Yokogawa may use or add copy protection in or onto the Licensed Software. In no event shall the Licensee remove or attempt to remove
such copy protection.

2.7 The Licensed Software may include a software program licensed for re-use by a third party (hereinafter called “Third Party Software”, which
may include any software program from affiliates of Yokogawa made or coded by themselves.) In the case that Yokogawa is granted
permission to sublicense to third parties by any licensors (sub-licensor) of the Third Party Software pursuant to different terms and conditions
than those stipulated in this Agreement, the Licensee shall observe such terms and conditions of which Yokogawa notifies the Licensee in
writing separately.

2.8 In no event shall the Licensee modify, remove or delete a copyright notice of Yokogawa and its licenser contained in the Licensed Software,
including any copy thereof.

Article 3 (Restriction of Specific Use)

3.1 The Licensed Software shall not be intended specifically to be designed, developed, constructed, manufactured, distributed or maintained for
the purpose of the following events:

a) Operation of any aviation, vessel, or support of those operations from the ground;,

b) Operation of nuclear products and/or facilities;,

c) Operation of nuclear weapons and/or chemical weapons and/or biological weapons; or
d) Operation of medical instrumentation directly utilized for humankind or the human body.

3.2 Even if the Licensee uses the Licensed Software for the purposes in the preceding Paragraph 3.1, Yokogawa has no liability to or
responsibility for any demand or damage arising out of the use or operations of the Licensed Software, and the Licensee agrees, on its own
responsibility, to solve and settle the claims and damages and to defend, indemnify or hold Yokogawa totally harmless, from or against any
liabilities, losses, damages and expenses (including fees for recalling the Products and reasonable attorney’s fees and court costs), or claims
arising out of and related to the above-said claims and damages.

Article 4 (Warranty)

4.1 The Licensee shall agree that the Licensed Software shall be provided to the Licensee on an “as is” basis when delivered. If defect(s), such
as damage to the medium of the Licensed Software, attributable to Yokogawa is found, Yokogawa agrees to replace, free of charge, any
Licensed Software on condition that the defective Licensed Software shall be returned to Yokogawa'’s specified authorized service facility
within seven (7) days after opening the Package at the Licensee’s expense. As the Licensed Software is provided to the Licensee on an “as
is” basis when delivered, in no event shall Yokogawa warrant that any information on or in the Licensed Software, including without limitation,
data on computer programs and program listings, be completely accurate, correct, reliable, or the most updated.

4.2 Notwithstanding the preceding Paragraph 4.1, when third party software is included in the Licensed Software, the warranty period and terms
and conditions that apply shall be those established by the provider of the third party software.

4.3 When Yokogawa decides in its own judgement that it is necessary, Yokogawa may from time to time provide the Licensee with Revision
upgrades and Version upgrades separately specified by Yokogawa (hereinafter called “Updates”).

4.4 Notwithstanding the preceding Paragraph 4.3, in no event shall Yokogawa provide Updates where the Licensee or any third party conducted
renovation or improvement of the Licensed Software.

4.5 THE FOREGOING WARRANTIES ARE EXCLUSIVE AND IN LIEU OF ALL OTHER WARRANTIES OF QUALITY AND PERFORMANCE,
WRITTEN, ORAL, OR IMPLIED, AND ALL OTHER WARRANTIES INCLUDING ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR
FITNESS FOR A PARTICULAR PURPOSE ARE HEREBY DISCLAIMED BY YOKOGAWA AND ALL THIRD PARTIES LICENSING THIRD
PARTY SOFTWARE TO YOKOGAWA.

4.6 Correction of nonconformity in the manner and for the period of time provided above shall be the Licensee’s sole and exclusive remedy for
any failure of Yokogawa to comply with its obligations and shall constitute fulfillment of all liabilities of Yokogawa and any third party licensing
the Third Party Software to Yokogawa (including any liability for direct, indirect, special, incidental or consequential damages) whether in
warranty, contract, tort (including negligence but excluding willful conduct or gross negligence by Yokogawa) or otherwise with respect to or
arising out of the use of the Licensed Software.
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Terms and Conditions of the Software License

Article 5 (Infringement)

5.1 If and when any third party should demand injunction, initiate a law suit, or demand compensation for damages against the Licensee under
patent right (including utility model right, design patent, and trade mark), copy right, and any other rights relating to any of the Licensed
Software, the Licensee shall notify Yokogawa in writing to that effect without delay.

5.2 In the case of the preceding Paragraph 5.1, the Licensee shall assign to Yokogawa all of the rights to defend the Licensee and to negotiate
with the claiming party. Furthermore, the Licensee shall provide Yokogawa with necessary information or any other assistance for
Yokogawa’s defense and negotiation. If and when such a claim should be attributable to Yokogawa, subject to the written notice to
Yokogawa stated in the preceding Paragraph 5.1, Yokogawa shall defend the Licensee and negotiate with the claiming party at Yokogawa’s
cost and expense and be responsible for the final settlement or judgment granted to the claiming party in the preceding Paragraph 5.1.

5.3 When any assertion or allegation of the infringement of the third party’s rights defined in Paragraph 5.1 is made, or when at Yokogawa’s
judgment there is possibility of such assertion or allegation, Yokogawa will, at its own discretion, take any of the following countermeasures at
Yokogawa'’s cost and expense.

a) To acquire the necessary right from a third party which has lawful ownership of the right so that the Licensee will be able to continue to use
the Licensed Software;

b) To replace the Licensed Software with an alternative one which avoids the infringement; or

¢) To remodel the Licensed Software so that the Licensed Software can avoid the infringement of such third party’s right.

5.4 If and when Yokogawa fails to take either of the countermeasures as set forth in the preceding subparagraphs of Paragraph 5.3, Yokogawa
shall indemnify the Licensee only by paying back the price amount of the Licensed Software which Yokogawa has received from the
Licensee. THE FOREGOING PARAGRAPHS STATE THE ENTIRE LIABILITY OF YOKOGAWA AND ANY THIRD PARTY LICENSING
THIRD PARTY SOFTWARE TO YOKOGAWA WITH RESPECT TO INFRINGEMENT OF THE INTELLECTUAL PROPERTY RIGHTS
INCLUDING BUT NOT LIMITED TO, PATENT AND COPYRIGHT.

Article 6 (Liabilities)

6.1 If and when the Licensee should incur any damage relating to or arising out of the Licensed Software or service that Yokogawa has provided
to the Licensee under the conditions herein due to a reason attributable to Yokogawa, Yokogawa shall take actions in accordance with this
Agreement. However, in no event shall Yokogawa be liable or responsible for any special, incidental, consequential and/or indirect damage,
whether in contract, warranty, tort, negligence, strict liability, or otherwise, including, without limitation, loss of operational profit or revenue,
loss of use of the Licensed Software, or any associated products or equipment, cost of capital, loss or cost of interruption of the Licensee’s
business, substitute equipment, facilities or services, downtime costs, delays, and loss of business information, or claims of customers of
Licensee or other third parties for such or other damages. Even if Yokogawa is liable or responsible for the damages attributable to Yokogawa
and to the extent of this Article 6, Yokogawa’s liability for the Licensee’s damage shall not exceed the price amount of the Licensed Software
or service fee which Yokogawa has received. Please note that Yokogawa shall be released or discharged from part or all of the liability under
this Agreement if the Licensee modifies, remodels, combines with other software or products, or causes any deviation from the basic
specifications or functional specifications, without Yokogawa’s prior written consent.

6.2 All causes of action against Yokogawa arising out of or relating to this Agreement or the performance or breach hereof shall expire unless
Yokogawa is notified of the claim within one (1) year of its occurrence.

6.3 In no event, regardless of cause, shall Yokogawa assume responsibility for or be liable for penalties or penalty clauses in any contracts
between the Licensee and its customers.

Article 7 (Limit of Export)
Unless otherwise agreed by Yokogawa, the Licensee shall not directly or indirectly export or transfer the Licensed Software to any countries other
than those where Yokogawa permits export in advance.

Article 8 (Term)

This Agreement shall become effective on the date when the Licensee receives the Licensed Software and continues in effect unless or until
terminated as provided herein, or the Licensee ceases using the Licensed Software by itself or with Yokogawa'’s thirty (30) days prior written notice
to the Licensee.

Article 9 (Injunction for Use)

During the term of this Agreement, Yokogawa may, at its own discretion, demand injunction against the Licensee in case that Yokogawa deems
that the Licensed Software is used improperly or under severer environments other than those where Yokogawa has first approved, or any other
condition which Yokogawa may not permit.

Article 10 (Termination)
Yokogawa, at its sole discretion, may terminate this Agreement without any notice or reminder to the Licensee if the Licensee violates or fails to
perform this Agreement. However, Articles 5, 6, and 11 shall survive even after the termination.

Article 11 (Jurisdiction)

Any dispute, controversies, or differences between the parties hereto as to interpretation or execution of this Agreement shall be resolved
amicably through negotiation between the parties upon the basis of mutual trust. Should the parties fail to agree within ninety (90) days after
notice from one of the parties to the other, both parties hereby irrevocably submit to the exclusive jurisdiction of the Tokyo District Court (main
office) in Japan for settlement of the dispute.

Article 12 (Governing Law)

This Agreement shall be governed by and construed in accordance with the laws of Japan. The Licensee expressly agrees to waive absolutely
and irrevocably and to the fullest extent permissible under applicable law any rights against the laws of Japan which it may have pursuant to the
Licensee’s local law.

Article 13 (Severability)
In the event that any provision hereof is declared or found to be illegal by any court or tribunal of competent jurisdiction, such provision shall be
null and void with respect to the jurisdiction of that court or tribunal and all the remaining provisions hereof shall remain in full force and effect.
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Product Overview

This software program consists of MEX-Functions for DL control, MEX-Functions for
WVF/WDF files, and the DL series library.

MEX-Functions for DL control are a group of functions used to control Yokogawa's digital
oscilloscopes (DL) and acquire data. The functions can be used on MATLAB to change
parameters on the DL such as the measurement range and to load the data from the DL
into a MATLAB matrix. In addition, the GUI panel which imitates the DL operation panel
can be used to easily control the DL and acquire waveform data.

The DL series library is used when the DL is accessed with the MEX-Function for DL
control described above.

MEX-Functions for WVF/WDF files are a group of functions used to access from the
MATLAB environment the waveform data (.wvf, and .wdf extension) that has been saved
with the DL. Of these two, accessing WVF files saved by the DL using the MEX-
Functions for WVF files requires either the WVF File Access API (model 707712) or the
WE Control API (model 707741, includes 707712). If you do not have either of these
APIs, please purchase the 707712 separately.

Note
This software program cannot load data that has been acquired with the logic input on the DL.

DL(digital oscilloscope)

------- A
DL series | 7077120r !
library 1 707741 .
DL hardware WVF file WDF file

The WVF File Access API (model 707712) is required to access
WVF files. Note that the WE Control API (model 707741) includes
707712.

Vi
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Product Overview

This software program connects the PC and the DL and controls the DL.

There are two method of controlling the DL. One method is to use the MEX-Functions
for DL control or the DL communication commands on MATLAB. The other method is to
display the DL control window (GUI) on MATLAB and control the DL visually on a
software control panel.

PC

MATLAB tool kit
for DL series

Controlled on MATLAB

GP-IB
— - —
- RS-232 -
- USB
h— - Ethernet -

MATLAB window

* The DL control window

cannot be started
using RS-232.

Window on MATLAB used to control the DL

DL control window (GUI) started from MATLAB.

DL (One unit)

L7480 mw.ij S===0_0
g OC?
H8ololo D
HsooE
07|28 0000

0|1 |

L1 L

— Control the DL using the MEX-Functions for DL control
or DL communication commands. Or, retrieve waveform
data or history data.

Control the DL visually on a software control panel

DL1600/DL1700E Series

DL7400 Series
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Product Overview

Controlling the DL on MATLAB

The DL is controlled by using the MEX-Functions for DL control or the DL communication
commands from the MATLAB command window. You can use the MEX-Functions for
DL control to change the record length setting or save waveform data in a format that
can be displayed on MATLAB. For a description of the MEX-Functions for DL control,
see section 4.1, “MEX-Functions for DL Control.” For a description of the DL
communication commands, see the Communication Interface User’s Manual for the
respective DL.

MATLAB Startup Window

~) MATLAB

Fle Edit Debug Deskiop Window Help

0 B"‘ b3 B oo ‘ﬂ =5 B ‘ 73 ‘Curremerar:tnry'IC\ngrsmFiIes\MATLAB?ﬂWnrk LIJ

Shorteuts [2] Howto Add (2] Vwhat's New

Workspace

LR d |l Command Window

f eS| 8| B - seekfEme T

Name £

Value |Clas‘5‘ To get started, sSelect MATLAE Help or Demos from

4

>

Command Window
Control the DL by entering the
MEX-Functions for DL control
or DL communication
commands.

Il

Current Directory | Workspace

Command Histary

%—— 2/7/06 10:50 AM —-%

Controlling the DL Using DL Communication Commands
You can enter DL communication commands on the MATLAB Command Window to
control the DL. The syntax is shown below. Enter the DL communication command in
the Msg parameter of the MEX-Functions for DL control.

Syntax >mexDLSend (Msg) ;

Example >mexDLSend(‘:CHANNEL1:DISPLAY 1')

viii
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Product Overview

Starting the Control Window Using MATLAB and Controlling the DL
Use MATLAB to open the front panel image of the DL (control window, see the next
page). You can control the DL from your PC as if you are using the DL panel keys.

For the DL1600, DL1700E, and DL7400 series, and the DL750 and DL750P

Control Window Example

Save the screen image

Select the control window size,
select the display update rate,

Option dialog box that opens by

Pause display update clicking the OPTION button

option x|

and change the brightness —‘

| ES
Update the screenH—L UPDATE | PAUSE

=101 x|

Size Update Interval

| r Ll |‘I Sec 'I Cancel |

|J smrluu:‘_;rl FILE I ST I |(: 2 Brightneszs

| " B0% ‘.7.
P R |

OPTION CAPTURE

CAPTURE (Save the Screen Image)
The waveform screen image on the PC can be saved as actual waveform data that is
readable from MATLAB. The image can be saved to a file in MAT or CSV format.

OPTION (Select the Control Window Size)

You can select the size of the control window that is displayed on your PC from the list of

choices below. When the display resolution of the PC is small, the control window can

be displayed reduced in size.

* 100%: Displays the screen image of the DL digital oscilloscope using the same
number of pixels as the number of pixels of the entire screen of the
connected oscilloscope.

* 75%: Displays the screen image of the DL digital oscilloscope using 75% of the
number of pixels of the entire screen of the connected oscilloscope.

* 50%: Displays the screen image of the DL digital oscilloscope using 50% of the
number of pixels of the entire screen of the connected oscilloscope.

OPTION (Select the Display Update Rate)

You can select the display update rate of the DL screen image from the following:

1 sto 1 hour, or minimum (fastest update rate on your system. Note that this setting
may place heavy load on the network.)

However, the actual display update rate may be slower than the specified update rate
depending on the network transmission system or the amount of communication load.

OPTION (Change the Brightness)
You can change the display brightness of the screen image.

UPDATE (Update the Screen)
You can manually update the screen image of the DL. This is used when the display
update rate is set to a low value or when the display update is paused.

PAUSE (Pause Display Update)

You can pause the display update operation.

Pausing the display update operation improves the response of the software program
such as when turning ON/OFF numerous items at once or when entering values from a
keyboard.
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Product Overview

Control Window
Environment Settings Keys

You can enter environmental settings using the keys below. These keys do not exist

on the DL.

+ OPTION: Set the window size, display update rate, and brightness
+ CAPTURE: Save the waveform screen image data

« UPDATE: Execute display update
+ PAUSE: Pause display update

e DL1600/DL1700E Series Digital Oscilloscopes

s R b
[Runn ing z:az ZHSs  SOnsdin
X . Hainid * 2

Mﬂm mu.n&.)mm

SIHFLE ’fl"l.&‘ fﬂ

CAL 16:
20.0 Usdiv
||mC Full

Close the Software.

e DL7400 Series Digital Oscilloscopes
Environment settings keys

oPTI

H.E-l amv
HF’,

RESET i

FELEL, ’,

n ,i

CAPTURE!

- Environment settings keys
(Keys not available on the
DL1600/DL1700E Series)

— —

(Keys not available on the DL7400 Series)

003,02,25 14:41:19 Normal
Btopped 65 T ZOMS,s  DOus/i CURSOR
: LM 310k 3> 'D,IPE

.................................................. OFF
T

Bl il il il woniliset it den s il Bl s

CH1 10:1 CHZ 10:1 Edge CH1 +

20.9 Usdiv | 20.0 Ursdiv Normal

OC  Full oc  Full 8.0y

N

OPTION l CAPTUR!

DATE PAUS)

©

XY
SETUP |DISPLAY| FILE WHEC

ansund cmtsmt]muusu] HATH ]

- |
MENHI il I g 3 s bl l
PRINT WHAGESAI SHIFT

“aco starmsTop
g TERTICAL HORIZONTAL | P TRIGGER ™"
= SEARCH ACTION
CH1
@, o
= chz
v | e | = =
o3 SHAPLE] ENHANC:
)
Ll k] @

= ® 000

cHs SNAPSHOT CLEAR TRACE HELP

E Close the Software.
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Product Overview

e DL750/DL750P Scope Corder
CHZ 8.500V div Hormal

B

CHZ

o

25000

~2.5000

<< Mairc 10k >7

DEPT

. T7EE+00

~223: 08403

2500, 0us ©

L 2500.0us

Stopped

(|- 2003,02,25 11:38:28)

Edge
fAuto

CHZ i
20.800V

=
ca  sTarTsTor RIS
- m -

A
—rEr—

CAL XY

&

Close the Software.

Environment setting
keys

(Keys not available

on the DL750/DL750P)
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Product Overview

For the DL9000 Series

File View Tools File | view Tools File View | Tools

YOKOGA

Fause
Update Larger D3

YOKOGAWA — 2006/02/07 11:03:12
10427

Slopped Stopped

Option dialog box
options____ x

Update Interval 1s '] Cancel

File > Save > Image (Save the Screen Image)
An image of the currently displayed screen is saved as a BMP-format file.

File > Save > Waveform (Save the Wave Data)
The waveform screen image on the PC can be saved as actual waveform data that is
readable from MATLAB. The image can be saved to a file in MAT or CSV format.

File > Exit (Close the Software)
The software is closed.

View > Zoom > Smaller, Standard, or Larger (Select the Control Window Size)
You can select the size of the control window that is displayed on your PC from the
following.

Smaller, Standard, Larger

View > Pause (Pause Display Update)

You can pause the display update operation.

Pausing the display update operation improves the response of the software program
such as when turning numerous items ON/OFF at once or when entering values from a
keyboard.

To restart display updating, choose View > Pause again.

View > Update (Update the Screen)
You can manually update the screen image of the control window. This is used when the
display update interval is set to a low value or when the display update is paused.

Tools > Option (Select the Display Update Interval)

You can select a display update interval for the control window from the following.
300ms,500ms, 1s,25s,5s,10s

However, the actual display update interval may be slower than the specified update
interval depending on the network transmission system or the amount of communication
load.

o IM 701991-61E
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PC System Requirements

e OS
Windows 2000 (Service Pack 3, 4) or Windows XP

e CPU
Pentium 111 800 MHz or higher

¢ Memory
256 MB or more (512 MB or more recommended)

e CRT
XGA or higher (SXGA or higher recommended)

e Color
256 colors or more (65536 colors (16 bpp) ore more recommended)

* Mouse
A mouse compatible with Windows 2000 (Service Pack 3, 4) or Windows XP.

e Communication Interface
GP-IB, Ethernet, USB, or RS-232.
However, RS-232 can be used only to carry out communications using the MEX-
Functions for DL control on MATLAB.

e Controllable DL Series Oscilloscopes
DL1600 Series
DL1700E Series
DL7400 Series
DL750, and DL750P
DL750/DL750P module

Model Note

701250 High-Speed 10 MS/s, 12-Bit Isolation Module (2CH)

701251 High-Speed High-Resolution 1 MS/s, 16-Bit Isolation Module (2CH)
701255 High-Speed 10 MS/s, 12-Bit Non-Isolation Module (2CH)
701260 High-Voltage 100 kS/s, 16-Bit Isolation Module (with RMS, 2CH)
701261 Universal (Voltage/Temp.) Module (2CH)

701262 Universal (Voltage/Temp.) Module (with AAF, 2CH)

701265 Temperature, High Precision Voltage Isolation Module (2CH)
701270 Strain Module (NDIS, 2CH)

701271 Strain Module (DSUB, Shunt-Cal, 2CH)

701275 Acceleration/Voltage Module (with AAF, 2CH)

701280 Frequency Module (2CH)

DL9000 Series

e MATLAB
Ver. 7.0 sp2 (Release14) or later

IM 701991-61E
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PC System Requirements

e Communication Function Necessary on the DL (One of the Following)
GP-1B: A Yokogawa product with GP-IB complying with IEEE St'd 488.2

Note

When performing communication using a Yokogawa product, set the terminator to LF and
EOI for normal operation and EOI for binary data transmission.

RS-232: RS-232 can be used only to carry out communications using the MEX-
Functions for DL control on MATLAB.

Note

Normally, set the parameters as follows:
» 8 bits, no parity, 1 stop bit
» CTS-RTS (hardware handshaking)
» Terminator: LF

USB: Yokogawa DL1600, DL1700E, DL7400, DL750, DL750P, or DL9000

Digital Oscilloscope with a USB interface.
Note

Set the terminator to LF and EOI or EOI. Do not turn OFF the power to the PC or the DL
when the line is connected.

Ethernet: DL1600, DL1700E, DL7400, DL750, DL750P, or DL9000 with an Ethernet
interface.

¢ Others
CD-ROM drive (for installation)

Xiv
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Notes on Using the Software

» Do not perform operations directly on the DL Series Digital Oscilloscope while using
this software program. If you do, operation errors can result.

« If the standby mode provided on your PC is activated, the operation of the software
may not be able to continue.

When using the software, turn OFF the standby mode.

« If you run the software using a NIC interface, the line load is 800 KB/s maximum and
400 KB/s or less in normal conditions.

Consult your network administrator on using the NIC interface.

» Do not set the network or communication parameters of the DL Series Digital
Oscilloscope using this software program. The connection may be disconnected.

« Do not execute self-tests using this software program.

» Only a single DL Series Digital Oscilloscope can be controlled by this software
program. In addition, simultaneous connections from multiple PCs to a single DL
Series Digital Oscilloscope are not allowed.

* You can run multiple instances of the software program on a single PC to control
multiple DL Series Digital Oscilloscopes. However, the operation may slow down
depending on the specifications of your PC or the line condition. In addition, the
program may not operate properly when multiple instances of this program are started
depending on the CPU or memory size of your PC.

» The thumbnail preview function of the DL1600/1700E Series Digital Oscilloscopes is
not supported. The thumbnail function and preview function of the DL7400 Series
Digital Oscilloscopes are not supported.

» If a connection error occurs when connecting to a DL digital oscilloscope, power-cycle
the DL.

IM 701991-61E
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Chapter 1 Preparations for Using the Software

1.1 Installing the MATLAB Tool Kit for the DL
Series

For the installation procedure of the MATLAB tool kit for DL series, read the paper
named Please Read before Installation (MATLAB tool kit for DL series) (IM701991-71E)
that comes with the software.

Note

When you install this software program, the MEX-Functions for DL control (see section 4.1)
and the MEX-Functions for WVF/WDF (see section 4.2, and 4.3) are also installed.

IM 701991-61E 1-1
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1.2 Initializing MATLAB

Carry out the procedure below once after installing this software.

1.  Start MATLAB.

<) MATLAB

File Edit Debug Dsskfop ‘Window Help

0| & B oo o | g B | ? | curent Directory: [ ¢ Program FiesmmatLag7 ok 7] |

Shortcuts (2] How to Add  [2] What's New

P3| Command Window

Workspace 2
H PSS | E | [ -|sackfpee -]
Wame £ [ vaue [ class

4

e

]

Current Directory | wiorkspace

Command History

5-— 2/7/06 10:50 AM --%

Setting the MATLAB Path

2.  From the File menu, choose Set Path. The Set Path dialog box opens.

<) MATLAB

|Fle Edt Debug Desktop Window Help
Nt = ‘ % ‘(
open... o [
Close Command Window
Impart Data... -
Save Workspace fs... Chrl+s  plack| Base ¥
SetPath... Class
Preferences...
Page Setup. .
Print...

Print Selection,

1 C:i...gawaiDLIDLSampleL.m
Exit MATLAB CirlQ

A4 cheanges inke eifect mmecissty.

To get started, sSelect MATLAE Help or Demos from

=lol x|

e labhelr
e labhe .
ehrreatlablsp

_te |

3. Click the Add Folder button and select the folder in which the MATLAB tool kit for

DL series was installed.

Note

The default installation destination folders are as follows.

» Version 7.0 sp1 or earlier

C:\MATLAB™****\toolbox\matlab\YOKOGAWA\DL

» Version 7.0 sp2 or later

C:\Program Files\MATLAB*****\toolbox\matlab\YOKOGAWA\DL

******: The version number.

4.  Click the Save button and then the Close button.

1-2
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Chapter 2 Preparations for Controlling the DL from MATLAB

2.1 Setting the DL Series Interface

When you install this software program, the MEX-Functions for DL control are also
installed. You will be able to control the DL Series oscilloscopes using the MEX-
Functions for DL control by carrying out the setup below.

1. Set the interface to be used from the front panel of the DL.
On the DL1600/DL1700E Series, DL750, and DL750P:
MISC > Remote Cntl > Device
On the DL7400 Series: MISC > Remote Control > Device
On the DL9000 Series: SYSTEM > Remote Control > Device

e Example (DL7480)
When GP-IB is selected = When USB is selected

MISC Renote Control 1] ifemote Control ] Remote Control ] Remote Control]]
Device Device Device
Calibration GP-1B
Network GP-1DB usB
4 L ﬁ Address ﬁ Own ID
Renote User USB
Control Account 1 1
Wl
SCSI ID = = Network b
7 ; T
Netuork .
- ;
System Config h
Overview ]
Next |
(1-2)
When Network is selected
Renote Control HISC etiBtunrk | TCP/IP Setup ]
Device 7] Al
Calibration TCP/IP THCP
Netuork Setup
IP fddress
4 (] Al
User Renote User Net Mask E5Y.E5Y.E54. 4
Account -»> Control -»> Account g
Gate Uay  [19.[ .28,
i {]
SCSI ID Mail DNS
Setup
4 {]
Netuwork Net Drive
Setup
q M
System Config Net Print
Setup
{]
Duerviey Others
Next Comnect
(1-2) Log List

IM 701991-61E 2-1
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2.2 Installing the USB Driver

For the DL1600, DL1700E, and DL7400 series, and the DL750 and DL750P, when
connecting a PC and the DL main unit via USB for the first time, the Found New
Hardware Wizard dialog box appears.

For the DL9000 series, see IM701310-91E contained in the CD-ROM.

Found New Hardware Wizard

This wizard helps pou instal saltware for

TESTME&SURE

(*) 1t your hardwars cams with an installation CD
> or floppy disk. insert it now.

‘what do you want the wizard to do?

 Inztall the software automatically [Recommendsd]
@ Install from a list or specific location [Advanced)

Click Next ta continue.

<Back [ Nests | Cancel |

1. Select the Install from a list of specific location.
2. Click Next. The following dialog box appears.

Found New Hardware Wizard

Please choose your search and installation options. .

@ Search for the best driver in these locations

Use the check bores below to limit or expand the: default search, which includes local
paths and removable media. The best diver found will be installed.

™ Search removable media (floppy, CO-ROM...]

¥ Include this lacation i the search:
[E-\Frogiam Fies'MATLAET THoabartYskoganalD =]

£ Don't search. | will choose the driver to instal

Chanse this option to select the device driver fiom a list Windows does not guarantes that
the diiver you choose will be the best match for pour hardware.

< Back Next > Cancel

3.  Set the following items:
+ Select the Search for the best driver in these locations.
+ Clear the Search removable media check box.
+ Select the Include this location in the search check box.

4.  Check that the folder name is as follows. If you installed the software program to a
folder other than the default folder, click Browse and specify the \Driver folder
under the installed location.
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2.2 Installing the USB Driver

Note
The default installation destination folders are as follows.
» Version 7.0 sp1 or earlier
C:\MATLAB*****\toolbox\matlab\Y OKOGAWA\DL\Driver
» Version 7.0 sp2 or later
C:\Program Files\MATLAB*****\toolbox\matlab\Y OKOGAWA\DL\Driver
**xxxx: The version number.

5.  Click OK.

The software is installed.

Completing the Found New
Hardware Wizard

\> DL series

‘Windows has finished installing the software for this device:

To close this wizard, click Finish

Elach I Finish I Cance!

aVv1LVIN wou 1a 3y Buijjosyuod 10} suoinesedaid

Note

To install the driver manually, right-click the ykusb.inf file in the folder below, and click Install.
If you installed MATLAB to a folder other than the default folder, the file is located in the
\driver folder in that location.

C:\MATLAB*****\toolbox\matlab\Y OKOGAWA\DL\Driver

‘\Program Files',MATLAB71' toolbox' Yokogawal

File Edit View Favorites Tools  Help

) Bk - - ) Sarch Folders -
Q-0 - 171/ |E

Addvess [ C:iprogram FilesiMaTLAB7 1 toolbocdvokagawalDLiCriver

File and Folder Tasks B Bevmmetii
Open
=i Rename this file

-
B Move this file T4, Print

) Copy this file X Open With...

3 Publish this file to the web " sendTo »
() E-mail this file —

Cut

& Print this il el

¥ Delete this file
Create Shorbeut
Delate

Other Places R Rename

o Properties
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2.3

Executing MEX-Functions for DL Control

The MEX-Functions for DL control are programmed interactively, which is a feature of
MATLAB. The DL can be controlled and waveform data can be retrieved into MATLAB
by executing a program on the MATLAB command window or through an m file.

Command window

-} MATLAB .

File Edit Debug Dsskfop Window Help

D@4 BB oo~

oo B | % | curentorectory: [cprogram FiesmatLagr ok ¥ ] .

Shortcuts (2] How to Add  [Z] What's New:

Current Directory - C:\Program Files\MATLAB71\work @ X

Command Window

oF W 5 ‘ ® - »» ret = mexDLComStart (4, 10.0.0.2,anonymous,'):
AllFies - |F|Ie Type |S\ZE |Last B §->>reti= mexDLEendi Stace )
s+ [ret,wave] - mexDLGetWave():
s> plot (wave) :
x
Ble Edt Yew Insert Tooks Deskop Window Help
PEE® h|QRAN®|w 08| =
012 T T T T
2 L)
= | 2 oosf
Currert Directory | Workspece |
Command History a X
0.06 -
Er4-- 2/7/06 10:26 A —-%
—ret = wexDLCowStart(4,'10.0.0.2,anonymous
~ret = wexDLSend('start'); ondl
~[ret,wave] = mexDLGetWave();
“plotjwave) ;
0.02 -
8 i
oo . . . L
a 2 4 B 8
m file editor
\MATLAB71'toolbox', Yokagawa',DL\DLSamplel.m —(Ol x|
Fle Edt Text Deskiop Window Help 2 x
DS E| L mRo o | S| F BHOEF0O
43 if ret ~= O =
44 ret = mexDLGetlastError;
45 return;
46  end;
47
48 % sending IDN? § receiving query
43 ret = mexDL3end| '*IDN?' |;
50 if ret ~= O
51 ret = mexDLGetlastError;
52 return;
53 end;
54
55 [ret,Buf,3ize] = mexDLReceive| 1000 |;
56 if ret ~= 0
57 ret = mexDLGetlastError;
58 return;
53  end;
60
61 % Places = device in local mode
62 ret = mexDLIetRen{ 0 ;
63 if ret ~= 0
64 ret = mexDLGetlastError;
65 return;
66 end;
67
68 Ret = mexDLComEnd;
63 if ret ~= 0
70 ret = mexDLGetlastError;
71 return; =l
DLSamplel h 1 cal 1 |ovR |y

Execution Example on the Command Window
>> ret = mexDLComStart(4,’10.0.236.100,anonymous,pass’);

>> ret = mexDL ( ‘STOP’' );
>> ret = mexDLSend(
>> ret = mexDLSend(
>> ret = mexDLComEnd;

‘CHANNEL:VDIV 500mV’ );
‘ACQUIRE:MODE NORMAL; RLENGTH 1000’ );
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2.4 Sample Programs Using the MEX-Functions
for DL Control

Each sample program is located in the folder in which the MATLAB Tool Kit of DL Series
was installed.

Sample Program 1
Below is a program for connecting the communication line and sending commands.
Remove the % character from the program line corresponding to the interface type you
are using.
The sample program is DLSample1.m.
Example >> [ret, Buf, Size] = DLSamplel

function [ret, Buf, Size] = DLSamplel()

% DL Sample 1

%

% Basic communication verification.

% Open communication > inquire ID > close communication

%

% Choose an interface type by removing ‘%’ in front of ret
% from the following lines ( between line no. 13 and 20 )
% You may need to adjust parameters of the interface.

Example-1:GPIB ( address = 1 )

ret = mexDLComStart(l,’1l");

Example-2:RS232 ( COM1,19200,8Bit-NoParity-1StopBit,NO-NO )

ret = mexDLComStart(2,’1,4,0,0');

Example-3:USB (ID=1)

ret = mexDLComStart(3,’1");

Example-4:Ethernet ( address=10.0.100.100, name=anonymous, password=123 ) % ret =
mexDLComStart(4,’10.0.100.100,anonymous,123");

aVv1LVIN wou 1a 3y Buijjosyuod 10} suoinesedaid

00 0° o 0P dP o o°

% if ret ~= 0

% ret = mexDLGetLastError;
% return;

% end;

% set terminal
ret = mexDLSetTerm( 2, 1 );

if ret ~= 0
ret = mexDLGetLastError;
return;

end;

% set timeout
ret = mexDLSetTimeout( 300 );

if ret ~= 0
ret = mexDLGetLastError;
return;

end;

% Places a device in remote mode
ret = mexDLSetRen( 1 );

if ret ~= 0
ret = mexDLGetLastError;
return;

end;

% sending IDN? & receiving query
ret = mexDLSend( ‘*IDN?’ );

if ret ~= 0
ret = mexDLGetLastError;
return;
end;
[ret,Buf,Size] = mexDLReceive( 1000 );
if ret ~= 0
ret = mexDLGetLastError;
return;
end;

% Places a device in local mode
ret = mexDLSetRen( 0 );

if ret ~= 0
ret = mexDLGetLastError;
return;

end;

Ret = mexDLComEnd;

if ret ~= 0
ret = mexDLGetLastError;
return;

end;
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2.4

Sample Programs Using the MEX-Functions for DL Control

Sample Program 2

Below is a program for connecting the communication line, capturing the waveform data
when a trigger is activated, and displaying the waveform of the data using the plot

function.

Remove the % character from the program line corresponding to the interface type you

are using.
The sample program is DLSample2.m.
Example >> [ ret, WaveData ] = DLSample2

function [ ret,WaveData ] = DLSample2()
DL Sample 2

Receive data as soon as triggering conditions are met.
Captured data is stored into ‘WaveData’ matrix.
Open communication > start signal acquisition >

transfer DL data to MATLAB matrix > close communication

Choose an interface type by removing ‘%’ in front of ret
from the following lines ( between line no, 15 and 22 )
You may need to adjust parameters of the interface.

00 0P O 0P OP 0P O° o OP oP oP

% Example-1:GPIB ( address =1 )

% ret = mexDLComStart(l,’1l");

% Example-2:RS232 ( COM1,19200,8Bit-NoParity-1StopBit,NO-NO )
% ret = mexDLComStart(2,'1,4,0,0");

% Example-3:USB (ID=1)

% ret = mexDLComStart(3,’1l");

%

Example-4:Ethernet ( address=10.0.100.100, name=anonymous, password=123 ) % ret =

mexDLComStart(4,’10.0.100.100,anonymous,123");

% if ret ~= 0

% ret = mexDLGetLastError;
% return;

% end;

% set terminal
ret = mexDLSetTerm( 2, 1 );

if ret ~= 0
ret = mexDLGetLastError;
return;

end;

% set timeout
ret = mexDLSetTimeout( 300 );

if ret ~= 0
ret = mexDLGetLastError;
return;

end;

WaveData = 0;

% Start signal acquisition
Ret = mexDLSend(‘sstart? 100');

if Ret ~= 0
Ret = mexDLGetLastError;
return;
end;
[Ret,Buf,Size] = mexDLReceive( 10 );
if Ret ~= 0
Ret = mexDLGetLastError;
return;
end;

% Receive DL data into WaveData matrix if a
% signal is triggered

if strcmp( deblank(Buf(l,:)), “:SST 0’ ) == 1
[Ret ,WaveData] = mexDLGetWave;
plot(WaveData);
if Ret ~= 0

Ret = mexDLGetLastError;
return;
end;
end;

% Set DL trigger mode to AUTO
mexDLSend( ‘ :TRIG:MODE AUTO');

%Close communication port
Ret = mexDLComEnd;

if ret ~= 0
ret = mexDLGetLastError;
return;

end;
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2.5 Starting/Closing the DL Control Window

Starting the DL Control Window
1. Start MATLAB.

) MATLAB

Fie Edt Debug Desktop Window  Help
O & B oo o | B B | P | curentoirectory: | cProgram Fieswia TLagT Hiwerk LIJ

Shortouts (2] How to Add  [2] What's New

B L] §|’E "|Sts:k' Base ~
To get started, select MATLAB Help or Demos fror
Marme 2 ‘ Walue | Class
#» mexbLéontrol; Enter MEX-Functions for DL

control or DL communication
commands

| | o

Wsrkspacs | Current irectory |

Command History A x

%-- 2/8/06 4:11 PM ——%

Entering the Command
2.  Enter the command below on the Command Window. The Communication Setup
dialog box opens.

> mexDLControl;

Communication Setup =|0] x|

= Ether

Hast [10.0.0.2]

Login

Login

¥ Anonymous

|
|

Port |
C—

 USB
 GPIB
Addrese
- USBTMC Select this check box when using USB
with the DL9000 series.
Serial Enter the DL9000 serial number.

Connect | Cancel |

Selecting the Interface
3.  Select the interface to be used and set the necessary parameters according to the
interface.

Note

» For details on how to operate the DL, see the user’s manual for the DL.

+ If the line was opened using mexDLComStart of the MEX-Functions for DL control, the
Communication Setup dialog box does not open. The DL control window (front panel
image) appears.

IM 701991-61E 2-7
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2.5 Starting/Closing the DL Control Window

4.  Click the Connect button. The DL control window opens.

Closing the DL Control Window
For the DL1600, DL1700E, and DL7400 series, and the DL750 and DL750P
1. Click the POWER button at the lower left corner of the DL control window or the X
button at the upper right corner of the window.
The DL control window closes.

For the DL9000 Series

1. Choose File > Exit from the DL main unit control screen, or click the X button in
the upper right of the screen.
The DL control window closes.
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2.6 Operations on the DL Control Window

Gives an example of the operation using a DL1700E series instrument.
Environment Settings

Setting the Window Size, Display Update Rate, and Brightness

Click OPTION on the Control Window to display the following dialog box. Set the items

as necessary.

Select the window size
Select the display update rate

Size Update Intepval

1 Confirm the settings

Oance|

(+ 100%

|

r T Erightness

(" B0% e . -

| | 7 Set the display brightness

Dark <——— Bright

Saving the Waveform Screen Image Data
Click CAPTURE on the Control Window. The Save As dialog box opens.

savens 21|
File name: Folders %
EBE cimeleseselek e
Cancel

= ot =] —I

[E= MATLABESP1

B wark

3 =

Save fle a¢ type: Drives
MAT Fies fmatl =] [Se =

Specify the save destination, file name, and file type. Then, click OK. The screen image
data is saved.
You can select from the following two file types.

. mat
e Ccsv
Note

If you save the data to a MAT file (*.mat), the file can be displayed on MATLAB.

Updating the Display and Pausing the Display Update Operation
Click PAUSE to pause the updating of the screen image of the DL.
Click UPDATE to update the screen image of the DL.

IM 701991-61E 2-9
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2.6 Operations on the DL Control Window

Control Window Operation

Using the Mouse

The displayed icon and the mouse operation vary depending on where the mouse
pointer is located on the control window. The following table shows the mouse operation
for each icon and the operation to the DL Series Digital Oscilloscopes.

Mouse Pointer Position

Displayed Icon and Operation

Mouse Operation

Panel key

&

Click operation

Same as pressing the panel key

Soft key menu or
dialog box

®

Click operation
Wheel operation

Same as pressing the soft key or button
Same as turning the jog shuttle

Voltage axis information

display area

B

Click operation
Wheel operation

Same as pressing the CH key
Same as turning the V/DIV knob

Time axis information

display area

%

Wheel operation

Same as turning the T/DIV knob

Area to the left or right of
the jog shuttle

19
Click operation
Wheel operation

Same as turning the jog shuttle to the left or right
Same as turning the jog shuttle

Area to the left or right of
the V/DIV knob

G R
Click operation
Wheel operation

Same as turning the V/DIV knob to the left or right
Same as turning the V/DIV knob

Area to the left or right of
the T/DIV knob

CE ) B
Click operation
Wheel operation

Same as turning the T/DIV knob to the left or right
Same as turning the T/DIV knob

2-10
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2.6 Operations on the DL Control Window

Example of Mouse Operation
1. Panel Key Operation
— Click to select Sine.

L0, 000ms
e 21 Line <, | Pulse ,n,mm‘l | PAUSE

LELR Slup

o0
WM .m:.)
MESET ’ I!r:!.&'!’

%ell's

-n—) FRESET :UW ,
CHY ' - - FIHPLE "'I.“I)‘( "9
_mr.

2. Soft Key Menu Operation
Operate the wheel in this condition to set the Record Length.

|—Click to select Envelope.

10000, Jus
fwerage Bux fey Ve e | PAUSE
h o | el

g: HELF

FELECT

FIHPLE I ’l’.’.(!‘{fg .

#osE ) PRES a‘«?’

= T e T FRUSE

SIHPLE )."l)l.n "9
NosE ’ PELLES (?’

Click or operate the wheel to
set the Record Length.

4. V/DIV Knob Operation
 Voltage axis information display area

Turn the wheel to change the
V/div setting.

Click or operate
the wheel.

IM 701991-61E 2-11
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2.6 Operations on the DL Control Window

5. T/DIV Knob Operation

rTime axis information display area
|

Dis==sE

wmm

FEok

Tornal

Lnz iy
CHL 1:1
10 onll-div
IC  Full
CHZ 109:1

Turn the wheel to change
the T/div setting.

Click or operate the wheel.

6. Dialog Box Operation
» Move to the item you wish to turn ON:

+ Set ON/OFF:

Trace Hode Comd [t ion

[ CHL — [PpFF[OH [ PUT T
EeHmm ] OFF PR FEOT R

[ tHF  [pFF_OR [T N

[ oW [PFF_OR [T N
Fathl — [PFFTOR [UT TN

Fathz — [PFF_OR [UT TN

ic [HD__OR

Sequence [ Flng (e Contlme’
fCO Count, [ TFTnlte

9

[E] Hard Copy

3ave to File

Click the jog shuttle or perform wheel
operation.

Click SELECT or click directly as shown in
the following figure.

2-12
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2.7 DL Control Example

Below is an example in which the MEX-Functions for DL control is used on MATLAB to
save the waveform image data on the DL7480 and show the waveform on MATLAB.

1. Enter mexDLControl; in the MATLAB Command Window.
The Communication Setup dialog box opens

<} MATLAB

Fle Edt Debug Deskop Window Help
0 D"l & B o o |H o B | % |Cul’l’emD\re:tnry'IC\ngrsmFiIes\MATLABH\Wnrk LIJ

Shortcuts (2] How to Add  [2] What's New

Workspace LIS Command Window
H P §|’@ "|Sia:k. Base *

To get started, select MATLAB Help or Demos frow
Nate L [ value [ctass ===

»» mexDLControl;

d | 5
Workspace | Current Dirsctary
Command History 5 =

%-- 2/8/06 4:11 PM ——%
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Communication Setup i =] [P |

@ Ether

Host fi0.0.0.7]

Login I

Login I

¥ Anonymous

 USB

Port 1 d

 GPIB

Address 1 d

 USB-TMC

Serial

Connect | Cancel

2.  Enter the settings as follows:
+ Select the Ether check box.
+ Enter the IP address you checked on the DL screen in the Host Address box.
+ Select the Anonymous check box.
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2.7 DL Control Example

3.  Click the Connect button.
The DL7480 front panel image appears.

OPTION CAPTURE

2004,04/15 15:53 :072 | ————mm————0c Normal

Runnimn 1676 T SHMS/s Z00usAdi
e 000 ¥ = WTT{-W» tiv UPDATE PAUSE
|| ¥
L%ﬁ] l st'mp]msmnv] FILE ] msc]
I

.®
&
.

PHAsE
vensure cursor|eomoco| mam |
WENY  WENY - \ )
e b
PRINT IMAGEsAEIE " sHiFr
=
“aca sTaRmS
R

TOP
ERTICAL HORIZONTAL| " TRIGEER ™

TH L

i

—i00d.0us 5 nin 1060, s
AT FpuLy Tk ZON5di

SEARCH ACTION

) © || @

iV THAERDIV
SHIPLE| ENHANCI
i o o o)
a
™ cHs @

"~ @ 000

| oy SNAPSHOT CLEAR TRACE HELP

TH L

I

-95. 6us 000 100, Zus
CH1 19:1 CHZ 10:1 Edge CH1 £
9.500 Usdiv | ©.500 Usdiv Autolevel
Full DC  Full 0.470 U

D

4. Click CAPTURE. The Save As dialog box opens.

o
SSESISESE=N=LY

sovens Y
File narne Folders: T |

mE - Thwark
Cancel
S =g ===

25 MATLABERSR!

= work
Bl -
Sawe file ¢ lype: Drives:
MAT Files [“mal) 7] IE c =

5.  Set the file type to MAT (*.mat) and specify the file name and destination.
6. Click OK. The DL7480 waveform image data is saved.

Showing the DL7480 Waveform Image Data on MATLAB
7. Open the MATLAB Workspace window.
8.  From the File menu, choose Open. The Open dialog box opens.

oeen 2l
Look ir: [ (3 work i R s
File name: | Open I
Files of type: [l MATLAB Files = Cancsl

9.  Specify the data you wish to display on MATLAB, and click Open. The Workspace
window shows the file name.
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2.7 DL Control Example

10. Right-click the file on the Workspace window and choose plot.

~) MATLAB

Fle Edt View Graphics Debug Desktop Window Help

D@ & B@B o |8 B %] crentore

Shorteuts [2] Howto Add (2] Vwhat's New

Workspace

E Open Selection > double

Save As..,

Copy atrhC
Duplicate D
Delete Delete

Renarme
Edit Value

( le)
bar (LocalDoble)
stem (LocalDouble)
stairs {LocalDouble)
area {LocalDouble)
| 3
pie (LocalDouble)
Current Dt ist {LocalDouble)

]

Command  Mors Plats... %

The waveform screen of the DL7480 appears.

i

File Edit Wiew Insert Took Window Help

lbczma/ xa 2/ 2po

12

aVv1LVIN wou 1a 3y Buijjosyuod 10} suoinesedaid

]
f

or rm-mﬂ-‘-“ r.m-'-"'—

-02

I L L L L L L I L
0 1000 2000 3000 4000 5000 6OO0 7000 8OO0 9000 10000
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Chapter 3 Retrieving Waveform Data of WVF/WDF Files into MATLAB

3.1

Using the MEX-Functions for Files

When you install this software program, the MEX-Functions for WVF/WDF files are also
installed along with the MEX-Functions for DL control in the same folder. Of these two,
using the MEX-Functions for WVF files requires that either the Model 707712 WVF File
Access API (sold separately) or the Model 707741 WE Control API be installed.

IM 701991-61E
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3.2 Execution Example Using the MEX-Functions

for Files

MEX-Functions for WVF/WDF files enables MATLAB-characteristic dialog-based
programming. The following are examples of using the MATLAB command window and
the MEX-Functions for WVF/WDF files in m files.

MATLAB Screen

<) MATLAB

Fle Edt Debug Deskiop Windaw Help
O & B o o | B B | P | curent Diectory: [ Program FieswaTLaBT ok v |

Shortouts (2] How to Add  [2] What's New

Workspace LI 3 Cormmand Window

E m =§|’@"|Sia:k.lﬁasell > filename = “wefl
Natns L [ v [ ciass ilenane =
i1

>> [ret, ComInfo, Chinfol = mexWeDPHeaderReadS(filename, 0, 4)
ret =

1)
ComInfo =

Samp | inghun: 1000
Chane [Wum: 4
SamplingInterval: 0.0010
PreTrigzer: 0
Hlnit: "s”
Date: '2003/05/23"
Time: "13:17:127

k| [ B
Currert Directory | wiorkspace Chinfao =

= T4 struct array with fields:
Command History a x Charne | Nane

Sealed

SealeB

Unit

>> [ret, data] = mexMeDPDataRead(filename, 0, -1, 50, 1000%4);
> filename = Twefl 2

£ilenane =

w12

> [ret, Acalnfo] = mexWeDPInitializefcalnfol2, -2, 1000, 0.001, 4)
ret =

1)

Execution Example on the Command Window

>> filename = ‘wvfl’
filename =
wvEl
>> [ret, ComInfo, ChInfo] = mexWeDPHeaderReadS(filename, 0, 4)
ret =
0

ComInfo =

Comment: ‘'
SamplingNum: 1000
ChanelNum: 4
SamplingInterval: 0.0010
PreTrigger: 0
XUnit: ‘s’
Date: ‘2003/05/23"
Time: "13:17:12"'

ChInfo =

1x4 struct array with fields:
ChanelName
ScaleA
ScaleB
Unit

>> [ret, data] = mexWeDPDataRead(filename, 0, -1, 50, 1000%4);
>> filename = ‘wvfl_ 2’
filename =
wvfl_ 2
>> [ret, AcgInfo] = mexWeDPInitializeAcqgInfo(2, -2, 1000, 0.001, 4)
ret =
0
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3.2 Execution Example Using the MEX-Functions for Files

AcgInfo =

1x4 struct array with fields:
channel
dataType
blockNum
startBit
effectiveBit
trigActive
record
recordLen
trigPosition
time
interval
vResolution
vOffset
trigLevel
trigwidth
plusOverData
minusOverData
nonData
dispMaxData
dispMinData

>> ret = mexWeDPHeaderWriteS(filename, 0, ComInfo, 4, ChInfo, AcqInfo)
ret =

m-file Example

0
>> ret = mexWeDPDataWrite(filename, 0, 1000, 4, AcgInfo, 50, data)
ret =

0
>>
sourceFilename = ‘wvfl’;
destinationFilename = ‘wvfl_dup’;
blockNo = 0;
ch = -1; % All channel
dataForm = 50; % WE_DOUBLE
maxData = -Inf;

minData = Inf;

[ret, SampleNum, ChNum] = mexWeDPGetSampleChNum(sourceFilename, blockNo)
SampleNum = double(SampleNum);

ChNum = double(ChNum) ;

% Read the header file

[ret, ComInfo, ChInfo] = mexWeDPHeaderReadS(sourceFilename, blockNo, ChNum)
samplingInterval = ComInfo.SamplingInterval

% read the data file

[ret, data] = mexWeDPDataRead(sourceFilename, blockNo, ch, dataForm, SampleNum * ChNum);
for ch=1 : ChNum
[ret, value] = mexWeDPHeaderItemRead(sourceFilename, ‘VResolution’, ch, blockNo)
VRes = str2num(value)
[ret, value] = mexWeDPHeaderItemRead(sourceFilename, ‘VOffset’, ch, blockNo)

VOfs = str2num(value)
for i=(ch-1)*SampleNum+l : ch*SampleNum

data(i) = data(i) * VRes + VOfs; % Convert to the voltage values from the
file values.
end
[ret, value] = mexWeDPHeaderItemRead(sourceFilename, ‘VMaxData’, ch, blockNo)

work = str2num(value) * VRes + VOfs;
if maxData < work
maxData = work
end
[ret, value] = mexWeDPHeaderItemRead(sourceFilename, ‘VMinData’, ch, blockNo)
work = str2num(value) * VRes + VOfs;
if minData > work
minData = work

end
end
plot(data(l:SampleNum)) % Display on graph
[ret, AcgInfo] = mexWeDPInitializeAcqgInfo(maxData, minData, SampleNum, samplingInterval,
ChNum)
AcgInfo(1l)

% Write the header file
ret = mexWeDPHeaderWriteS(destinationFilename, blockNo, ComInfo, ChNum, ChInfo, AcqInfo)
for ch=1 : ChNum
[ret, VUnit] = mexWeDPHeaderItemRead(sourceFilename, ‘VUnit’, ch, blockNo)
ret = mexWeDPHeaderItemWrite(destinationFilename, ‘VUnit’, ch, blockNo, VUnit)
end
% Write the data file
ret = mexWeDPDataWrite(destinationFilename, blockNo, SampleNum, ChNum, AcgInfo,
dataForm, data)

IM 701991-61E
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3.3 Sample Programs

Sample Program for WVF Files
Below is an example for retrieving the header information of a WVF file and displaying
the waveform data using the plot function. Copy Sample.wvf and Sample.hdr to the
current directory such MATLAB\work before using them.
The sample program is DLSample3.m.
Example >> [ ret ] = DLSample3

function [ ret ] = DLSample3()

DL Sample 3

%

%

%

% Open ‘Sample.wvf’ file located in the current directory.
% Both ‘Sample.wvf’ and ‘Sample.hdr’ need to be in the directory.
% DL waveform data is stored into ‘data’ matrix.

% Either 707741 or 707712 is required to run this program.
file='Sample’;

blockNo=0;

ch=-1;

dataForm=50;

dispNum = 0;

[ret,SampleNum, ChNum]=mexWeDPGetSampleChNum(file, blockNo);
SampleNum=double(SampleNum) ;
ChNum=double (ChNum) ;

for ch=1:ChNum
[ret,value]=mexWeDPHeaderItemRead(file, 'VDataType’, ch, blockNo);
% Skip data from logic input of the DL series
if ~strncmp( value, ‘B’, 1)
dispNum = dispNum + 1;
[ret, data]=mexWEDPDataRead(file,blockNo,ch,dataForm, SampleNum );
[ret,value]=mexWeDPHeaderItemRead(file, 'VResolution’, ch, blockNo);
Vres=str2num(value);
[ret,value]=mexWeDPHeaderItemRead(file, 'VOffset’, ch, blockNo);
Voff=str2num(value);
wave = data*Vres+ones(1l,SampleNum)*Voff;
if 1 == ch
WaveData = wave;
else
WaveData = [WaveData; wave] ;
end
end
end

plot( WaveData );
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3.3 Sample Programs

Sample Program for WDF Files
Below is an example for retrieving the header information of a WDF file and displaying
the waveform data using the plot function.

AR R R R R R AR R R AR R LR R A R LR AR LR R AL

%

% M-File : WdfSample

% WDF file access sample script- 4

%

% Copyright (C) 2006 Yokogawa Electric Corporation

% Software Japan. All rights reserved.

K

R R R A A R A A L ] o

filename = input( 'filename = ', 's' ); )

[ ret, chNum ] = mexWdfGetChNum( filename ); =

block = 0; o

for ch = 0 : double( chNum ) -1 <.
: E:
% Get file parameters
3 =
[ret, traceName] = mexWdfItemRead(filename, 'TraceName', ch, 0); g
[ret, vScaleUpper] = mexWdfItemRead(filename, 'VScaleUpper', ch, block); (_Dh
[ret, vScaleLower] = mexWdfItemRead(filename, 'VScaleLower', ch, block); [
[ret, hResolution] = mexWdfItemRead(filename, 'HResolution', ch, block); §
[ret, hOffset] = mexWdfItemRead(filename, 'HOffset', ch, block);
[ret, vUnit] = mexWdfItemRead(filename, 'VUnit', ch, block); E
[ret, hUnit] = mexWdfItemRead(filename, 'HUnit', ch, block); S-
%
% Get waveform data 9..
%
clear data x; 5
[ret, param, data] = mexWdfScaleDataRead(filename, ch, block); T
x(1 : param.cntOut) = [hOffset : hResolution : hResolution * ( param.cntOut E

- 1) + hOffset]; o
% m
% Display waveform data to a graph M
% =3
subplot (double(chNum), 1, ch + 1); 8
plot(x, data); =
title(traceName); Eo-
axis([x(1l) x(param.cntOut) vScaleLower vScaleUpper]); o
ylabel(strcat('Amplitude [',vUnit,']1')); E

end

xlabel( strcat('Time [',hUnit,']")); I_-|

>
v1)
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Chapter 4 List of Functions

4.1 MEX-Functions for DL Control

You can control the DL or retrieve waveform data by entering MEX-Functions for DL
control or DL communication commands on the Command Window of MATLAB.

List of MEX-Functions for DL Control

mex Function Name Function Page

[ret] = mexDLComStart( wire, Adr ); 4-2
Initializes the line and connects the line to the specified device.

[ret] = mexDLDeviceClear; 4-3

Executes the clearing (SDC) of the selected device.
A dedicated command for the GP-IB.

[ret] = mexDLSend( Msg ); 4-3
Sends a message to the device.
[ret] = mexDLSendByLength( Msg, len ); 4-4

Sends the specified number of bytes of the message to the device.
[ret] = mexDLSendSetup;

Prepares to send a message to the device. 4-4
[ret] = mexDLSendOnly( Msg, len, end ); 4-4
Sends the specified number of bytes of the message to the device.
[ret,buf,size] = mexDLReceive( blen ); 4-5
Receives a message from the device.
[ret] = mexDLReceiveSetup;
Prepares to retrieve a message from the device. 4-5
[ret,buf,size] = mexDLReceiveOnly( blen ); 4-6
Receives a message (after preparation) from the device.
[ret,length] = mexDLReceiveBlockHeader; 4-6
Receives the header section of the block data sent from the device,
and returns the number of data bytes that follow.
[ret,buf,size,end] = mexDLReceiveBlockData( blen ); 4-7
Receives the data section of the block data sent from the device.
[end] = mexDLCheckEnd; Returns whether the message from the device is finished. 4-7
Can be used on the GP-IB, USB, or Ethernet interface.
[ret] = mexDLSetRen( flag ); 4-8

Sets the device in remote or local mode. Use of an interface other
than GP-IB is limited to Yokogawa products.
[errorID] = mexDLGetLastError; 4-9
Returns the number of the last error that occurred due to a
MATLAB command.

[ret] = mexDLSetTerm( eos, eot ); 4-10
Sets the terminator used in the message transmission/reception.

[ret] = mexDLSetTimeout( tmo ); 4-10
Sets the communication timeout time.

[ret,WaveData] = mexDLGetWave; 4-11
Retrieves the measured data.

[ret,WaveData] = mexDLGetWave( traceNum, waveStart, waveEnd ); 4-12
Specifies the trace number and waveform range and retrieves the
waveform data.

[ret,HistoryWave] = mexDLGetHistoryWave ( rec ); 4-13
Retrieves the history waveform data.

[ret,HistoryWave] = mexDLGetHistoryWave( rec, traceNum, waveStart, waveEnd ); 4-14
Specifies the record number, trace number and waveform range and
retrieves the history waveform data.

mexDLControl; Starts the DL control window. 4-15

[ret] = mexDLComEnd; Closes the line connected to the device. 4-15

mexDLToolkit; Displays the version information of the software. 4-15

IM 701991-61E 4-1
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4.1 MEX-Functions for DL Control

[ret] = mexDLComStart( wire, Adr );

Function: Initializes the line and connects the line to the specified device.
Parameters: wire Line type
Adr Character sequence of the line-specific address
Return value:ret ( 0 = OK, 1 = ERROR )
Description: Parameter description

wire Specify the type of line connected to the device to be controlled.
The value for each device is as follows:
GP-IB: wire = 1
RS-232: wire = 2
USB: wire = 3
Ethernet: wire =4
USB-TMC: wire =5
Adr Setthe GP-IB address or the RS-232 value of the device to be
controlled as a character string.
Below are the settings for each interface.
GP-IB: Adr="1"to “30” (GP-IB address of the device)
RS-232: Adr = “port number, baud rate number, bit
specification, handshaking number”

Port number 1 = COM1
2 = COM2
3 =COMS3

Baud rate number 0=1200
1 =2400
2 =4800
3 =9600
4 =19200
5 = 38400
6 = 57600

Bit specification 0 = 8 bit, no parity, 1 stop bit

1 =7 bit, even parity, 1 stop bit
2 = 7 bit, odd parity, 1 stop bit
Handshaking number 0 = NO-NO
1 = XON-XON
2 = CTS-RTS
USB: Adr = “1”"to “127” (USB ID of the device)
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Ethernet: Adr = “server name, user name, password”

Server name DL server name or IP address
User name User name
Password Password
When the user name is anonymous, the password is not
necessary.
(The delimiting comma is necessary.)
USB-TMC: Adr = “DL9000 series serial number”

Example: > ret = mexDLComStart(l,'l');
> ret = mexDLComStart(4’10.0.222.111,user,password’);

[ret] = mexDLDeviceClear;
Function: Executes the clearing (SDC) of the selected device. A dedicated
command for the GP-IB.

Parameters: None

Return value:ret ( 0 = OK, 1 = ERROR )

Description: This function applies only to the device connected to the GP-IB; it
does nothing to a device connected by a different interface.

Example: > ret = mexDLDeviceClear;

[ret] = mexDLSend( Msg );

Function: Sends a message to the device.
Parameters: Msg Character sequence of the DL communication command
Return value: ret ( 0 = OK, 1 = ERROR )
Description: Parameter description
Msg Setthe DL communication command character string.
To send a single DL communication command in segments, use
“mexDLSendSetup” and “mexDLSendOnly”.
Example: > ret = mexDLSend(‘:CANNEL1:DISPLAY 1');

> ret = mexDLSend(’start’);

> ret mexDLSend(‘stop’);
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4.1 MEX-Functions for DL Control

[ret] = mexDLSendByLength( Msg, len );

Function: Sends the specified number of bytes of the message to the device.
Parameters: Msg Character sequence of the DL communication command
len The number of bytes of the DL communication command to be
sent
Return value: ret ( 0 = OK, 1 = ERROR )
Description: Parameter description
Msg Setthe DL communication command.
len Setthe number of bytes of the DL communication command to
be sent.
Can be sent even when binary data is included in the DL
communication command.
To send a single message in segments, use “mexDLSendSetup”
and “mexDLSendOnly”.
Example: > ret = mexDLSendByLength(‘:CHANNEL1:DISPLAY 1’,
19);

[ret] = mexDLSendSetup;

Function: Prepares to send a message to the device.

Parameters: None

Return value:ret ( 0 = OK, 1 = ERROR )

Description: Prepares to send a message to the device.
Execute this function once before transmitting a single message in
several transmissions.
Use mexDLSendOnly to actually transmit the message.

Example: > ret = mexDLSendSetup;

[ret] = mexDLSendOnly( Msg, len, end );

Function: Sends the specified number of bytes of the message to the device.
Parameters: Msg Character sequence of the DL communication command
len The number of bytes of the DL communication command to be
sent
end End flag
Return value:ret ( 0 = OK, 1 = ERROR )
Description: Parameter description
Msg Set the message.
len Setthe number of transmitted bytes of the message.
end Set whether this transmission is the end of the transmission.
Set 1 if this is the end of the transmission. Set 0 to continue the transmission.

4-4
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4.1 MEX-Functions for DL Control

Transmits the DL communication command to the specified device.
Can be sent even when binary data is included in the DL
communication command.
When the end flag is set to 1, a terminator is transmitted at the end of
the DL communication command.
Therefore, while the end flag is 0, the device determines that the
transmission is a part of an ongoing message.

Example: > ret = mexDLSendOnly(‘:CANNEL1:DISPLAY 1’, 80,0);

[ret, buf, size] = mexDLReceive( blen );

Function: Receives a message from the device.

Parameters: blen Receive size (in bytes)

Return value: ret ( 0 = OK, 1 = ERROR )
buf Receive data buffer
size The actual number of received bytes.

Description: Parameter description
blen Set the maximum number of bytes of the message to be

received (this is normally the number of bytes of the buffer).

Return value description
buf Set the buffer that will store the received message.
size Returns the actual number of received bytes.
Receives a message from the device. If a terminator is detected, the
data is received up to the terminator. Otherwise, the data is received
up to the number of bytes specified by blen.
To receive the data of a message such as “wAveform: SEND?” and
“IMAGe:SEND?"” when communicating with a Yokogawa digital
oscilloscope, use “mexDLReceiveBlockHeader” and
“mexDLReceiveBlockData”.

Example: > [ret,buf,size] = mexDLReceive(80);

[ret] = mexDLReceiveSetup;

Function: Prepares to retrieve a message from the device.

Parameters: None

Returnvalue:ret ( 0 = OK, 1 = ERROR )

Description: This function is executed to prepare for the reception of large data
from the device in segments.
The actual data is received using mexDLReceiveOnly.

Example: > ret = mexDLReceiveSetup;

IM 701991-61E
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4.1 MEX-Functions for DL Control

[ret, buf, size] = mexDLReceiveOnly( blen );

Function:
Parameters:
Return value:

Description:

Example:

Receives a message (after preparation) from the device.

blen Receive size (in bytes)

ret ( 0 = OK, 1 = ERROR )

buf Receive data buffer

size The actual number of received bytes.

Parameter description

blen Setthe maximum number of bytes of the message to be
received (this is normally the number of bytes of the buffer).

Return value description

buf Set the buffer that will store the received message.

size Returns the actual number of received bytes.

Use this function when receiving large data in segments.

Receive the message from the specified device after preparing for the

reception using mexDLReceiveSetup.

If a terminator is detected, the data is received up to the terminator.

Otherwise, the data is received up to the number of bytes specified by

blen.

> [ret,buf,size] = mexDLReceiveOnly(80);

[ret, length] = mexDLReceiveBlockHeader;

Function:

Parameters:
Return value:

Description:

Example:

Receives the header of the block data sent from the device, and
returns the number of data bytes that follow.

None

ret ( 0 = OK, 1 = ERROR )

length The number of bytes of the block data

Return value description

length Returns the number of bytes of the block data.

This function is used first when receiving the block data.

The return value “length” contains the number of bytes that follow.
Receive the data by specifying this number of bytes + 1 (for the
terminator) in mexD1ReceiveBlockData.

> [ret,length] = mexDLReceiveBlockHeader;

4-6
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[ret, buf, size, end] = mexDLReceiveBlockData( blen );

Function:
Parameters:

Receives the data section of the block data sent from the device.
blen Receive size (in bytes)

Return value:ret ( 0 = OK, 1 = ERROR )

Description:

Example:

buf Receive data buffer

size The actual number of received bytes.

end End flag

Parameter description

blen Setthe maximum number of bytes of the message to be
received (this is normally the number of bytes of the buffer).

Return value description

buf Set the buffer that will store the received message.

size Returns the actual number of received bytes.

end Returns whether the reception of the number of data bytes
indicated by X>mexDLReceiveBlockHeader has been
completed.
If it is, 1 is returned. If not, O is returned.

This command is used to receive block data (message starting with #)
Receive the message from the specified device after preparing for the

reception using mexDLReceiveBlockHeader.
If a terminator is detected, the data is received up to the terminator.

Otherwise, the data is received up to the number of bytes specified by

blen.

> [ret,buf,size,end] = mexDLReceiveBlockData(80);

[end] = mexDLCheckEnd;

Function:
Parameters:

Return value:
Description:

Example:

Returns whether the message from the device is finished. Can be
used on the GP-IB, USB, or Ethernet interface.

None

end 1 = message remaining, 0 = message is finished

When a sequence of messages is received in segments, this function

returns whether all the messages has been received by
mexDLReceiveOnly.
> end = mexDLCheckEnd;
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[ret] = mexDLSetRen( flag );

Function:
Parameters:

Return value:
Description:

Example:

Sets the device in remote or local mode. Use of an interface other
than GP-IB is limited to Yokogawa products.

flag Remote (1)/Local (0)

ret ( 0 = OK, 1 = ERROR )

Parameter description

flag To set to remote mode send 1; to set to local mode send 0.
The behavior varies slightly depending on the interface type.

For GP-IB, the REN line is set to TRUE/FALSE.

Therefore, remote mode is actually enabled when a message is sent
to the device. (Remote/Local operation on the individual device is not
carried out.)

In the case of RS-232, USB, and Ethernet, the use of this function is
limited to Yokogawa products complying with 488.2 that support the
COMMunicate group commands. In this case, remote/local operation
on the individual device is possible.

> ret = mexDLSetRen(1l);

4-8
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[errorID] = mexDLGetLastError;

Function:

Parameters:

Return value:

Description:

Example:

Returns the number of the last error that occurred due to a MATLAB
command (not the error code on the DL).
int id Device ID
Error number
Return value description
ErrorID Returns the last error number that occurred on the device.
0x00000000(0) No error
0x00000001(1) Timeout
0x00000002(2) Device Not Found
0x00000004(4) Open Port Error
0x00000008(8) Device Not Open
0x00000010(16) Device Already Open
0x00000020(32) Controller Not Found
0x00000040(64)
0x00000100(256) Send Error
0x00000200(512) Receive Error
0x00000400(1024) Data is not Block Data
0x00001000(4096) System Error
0x00002000(8192) Device ID is lllegal
When the return value of a function including the initialization function
is not 0 (= OK), this function is used to retrieve the actual error
number.

Parameter is illegal

> errorID = mexDLGetLastError;

IM 701991-61E
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[ret] = mexDLSetTerm( eos, eot );

Function:
Parameters:

Return value:
Description:

Example:

Sets the terminator used in the message transmission/reception.
eos Terminator

eot EOT

ret ( 0 = OK, 1 = ERROR )

Parameter description

eos Set the terminator. Below are the settings.

eos = 0: CR+LF

eos = 1: CR

eos = 2. LF

eos = 3: EOI (GPIB) or none (RS-232, USB, or Ethernet)

When the interface is GP-IB and eos is 3, use eot to specify whether
EOI will be used.
eot Set whether EOI will be used for the terminator.
This is dedicated to the GP-IB.

In general, when communicating with a Yokogawa product, use the
settings below on all interfaces.

mexDLSetTerm( 2,1 ); /* eos = LF, eot = TRUE */

If eos = LF is used when receiving binary data and the binary code
contains an LF code, the DL will decide that the data ends there.
However, when receiving block data from a Yokogawa product using
“mexDLReceiveBlockHeader” and
“mexDLReceivceBlockData”, you do not have to switch the
terminator.

> ret = mexDLSetTerm(1l,0);

[ret] = mexDLSetTimeout( tmo );

Function:
Parameters:
Return value:
Description:

Sets the communication timeout time.
tmo Timeout time (100 to 6553600 ms)
ret ( 0 = OK, 1 = ERROR )
Parameter description
tmo Sets the timeout value. 100 ms unit.
If tmo = 0
GP-IB: Timeout set to infinity.

Others: Timeout not set.

Note

“Infinity” means that the wait time is set to an infinite amount of time. “Not set” means that
there is no wait time (responds immediately).

Sets the communication timeout time.

4-10
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4.1 MEX-Functions for DL Control

For a Yokogawa product, set the time greater than equal to 30 s.
(Even if the timeout time is set long, the overall performance is not
affected.)

Example: > ret = mexDLSetTimeout(300);

[ret, WaveData] = mexDLGetWave;

Function: Retrieves the measured data.
Parameters: None
Return value:ret ( 0 = OK, 1 = ERROR )

WaveData Matrix of waveform data

Description: Return value description

WaveData All of the waveform data of the specified record length are
stored to a matrix for each displayed channel.

W1,1 . . . W1,cn
WaveData = )

Ween1 . . . Weencn

When retrieving waveform data of long record length, set the timeout
time to a relatively large value.

>> ret = mexDLSetTimeout(1000);

Data acquired using the logic input on the DL

cannot be stored.

Example: > [ret,WaveData] = mexDLGetWave;

Note

> plot(Wavedata)
> plot(Wavedata(:,2)); % Displays the waveform of Ch2

When storing large quantities of waveform data into a MATLAB matrix using this command and the memory area
needed to store the data cannot be allocated continuously, a message “Out of Memory” appears. The size of
continuous memory that can be allocated varies depending on your PC’s environment. If this message appears,
take the following measures to retrieve the data.

.

Expand the memory swap space
The procedure for Windows 2000 is described below. For other Windows versions, see the respective
Windows manual.

1. Right-click My Computer and choose Properties.

2. Select the Advanced tab and select Performance Options.

3. Click Change and change the virtual memory size.

Reduce the size of the matrix

Use the function for retrieving the data by specifying the waveform range

[ret, WaveData] = mexDLGetWave( traceNum, waveStart, waveEnd );

to divide the large matrix into several smaller matrices. This reduces the amount of data that MATLAB
handles at one time.
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4.1 MEX-Functions for DL Control

[ret, WaveData] = mexDLGetWave ( traceNum, waveStart, waveEnd );

Function:

Parameters:

Return value:

Details:

Example:

Specifies the trace number and waveform range and retrieve the

waveform data.

traceNum Trace number of the waveform for retrieving the data

waveStart Start point of the waveform data to be retrieved (can be

omitted)

waveEnd End point of the waveform data to be retrieved (can be omitted)

ret ( 0 = OK, 1 = ERROR )

WaveData Waveform data matrix (each element is double type)

Parameter description

traceNum Specify the trace number. The minimum value is 1. The
largest value depends on the number of channels on the connected
model. If 0 is specified, the waveforms of all displayed channels are
retrieved. Trace numbers of hidden channels cannot be specified.

waveStart,waveEnd Specify the range of waveform data to be
retrieved. The range of waveStart and waveEnd is a value within the
display record length. In addition, waveStart and waveEnd can be
omitted (you cannot omitted only one of the parameters). When omitted,
the entire waveform data of the displayed record length is retrieved.

Return value description

WaveData The waveform data of the specified trace number in the
specified range within the display record length is stored in a matrix.
The data of hidden channels on the screen cannot be retrieved.

W1 W1 . - - W1 ,Ch
WaveData =

WLen.l . - - WLen.Ch

When CH1, CH2, and CH4 are shown on the display (with a display
record length of 10 kW)
> [ret,WaveData] = mexDLGetWave(0);
%Retrieve all the waveform data of CH1, CH2, and CH4.
> [ret,WaveData] = mexDLGetWave(l);
%Retrieve all the waveform data of CH1.
> [ret,WaveData] = mexDLGetWave(1l,1000,4000);
%Retrieve the waveform data between 1 kW to 4 kW on CH1

Note

Use the following function to retrieve the specified record length of data from a saved .wvf file using

MexFunctions for WVF Files.

[ret,data] = mexWeDPCsRead(filename,seriesNo,start,length,ch,dataForm,dataNum)
You can retrieve the data by specifying the start and length parameters.

If the .wvf files are not consecutive, you can retrieve the data by setting seriesNo to -1.

IM 701991-61E



4.1 MEX-Functions for DL Control

[ret, HistoryWave] = mexDLGetHistoryWave ( rec );

Function:
Parameters:

Return value:

Retrieves the history waveform data.

Rec Record No. The newest (current) waveform is 0, the waveform
previous to that is —1, and so on. For the
selectable range, see the user's manual for the
respective DL.

ret ( 0 = OK, 1 = ERROR )

HistoryWave Matrix of historical waveform data

Description: Return value description
HistryWaveData The waveform data of the specified record number
are stored to a matrix for each displayed channel.
W1,1 - . - W1.Ch
HistroyWave = -
.VVLenJ . . .VVLen,Ch
When retrieving waveform data of long record length, set the timeout
time to a relatively large value.
>> ret = mexDLSetTimeout(1000);
Data acquired using the logic input on the DL
cannot be stored.
Example: > [Ret,HistoryWave] = mexDLGetHistoryWave( -20 );
Retrieve the —20th history waveform.
Note

When storing large quantities of waveform data into a MATLAB matrix using this command and the memory area

needed to store the data cannot be allocated continuously, a message “Out of Memory” appears. The size of
continuous memory that can be allocated varies depending on your PC’s environment. If this message appears,
take the following measures to retrieve the data.

» Expand the memory swap space
The procedure for Windows 2000 is described below. For other Windows versions, see the respective
Windows manual.
1. Right-click My Computer and choose Properties.
2. Select the Advanced tab and select Performance Options.
3. Click Change and change the virtual memory size.

» Reduce the size of the matrix
Use the function for retrieving the data by specifying the waveform range
[ret,HistoryWave] = mexDLGetHistoryWave( rec, traceNum, waveStart, waveEnd );
to divide the large matrix into several smaller matrices. This reduces the amount of data that MATLAB
handles at one time.

IM 701991-61E
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[ret, HistoryWave] = mexDLGetHistoryWave (rec, traceNum,

waveStart, waveEnd);

Function:

Parameters:

Return value:

Details:

Example:

Specifies the record number, trace number and waveform range and

retrieves the history waveform data.

rec Record number

traceNum Trace number of the waveform for retrieving the data

waveStart Start point of the waveform data to be retrieved

(can be omitted)
waveEnd  End point of the waveform data to be retrieved (can be
omitted)

ret ( 0 = OK, 1 = ERROR )

HistoryWave History waveform data matrix (each element is double type)

Parameter description

Rec Record No. The newest (current) waveform is 0, the waveform
previous to that is —1, and so on. For the selectable range, see the
respective DL User’'s Manual.

traceNum Specify the trace number. The minimum value is 1. The
largest value depends on the number of channels on the connected
model. If 0 is specified, the waveforms of all displayed channels are
retrieved. Trace numbers of hidden channels cannot be specified.

waveStart,waveEnd Specify the range of waveform data to be
retrieved. The range of waveStart and waveEnd is within the display
record length. In addition, waveStart and waveEnd can be omitted
(you cannot omitted only one of the parameters). When omitted, the
entire waveform data of the displayed record length is retrieved.

Return value description

HistoryWave The waveform data of the specified record number are
stored to a matrix for each displayed channel. The data of hidden
channels on the screen are not retrieved.

Wi . . . Wicn

HistroyWave =

WLen.1 - . - WLen.Ch

When CH1, CH2, and CH4 are shown on the display (with a display

record length of 10 kW)

> [ret,HistryWave] = mexDLGetHistoryWave(-20,0);
%Retrieve the -20th history waveform of CH1, CH2, and CH4.

> [ret,HistryWave] = mexDLGetHistoryWave(-20,4);
%Retrieve the entire data of the -20th history waveform of CH4.

> [ret,HistryWave] = mexDLGetHistoryWave(-20,4,

2000,5000);

%Retrieve the -20th history waveform data of CH4 between 2kW
and 5 kW.
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mexDLControl;

Function:
Parameters:
Return value:
Example:

Starts the DL control window.
None
None

> mexDLControl;

[ret] = mexDLComENnd,;

Function:
Parameters:
Return value:

Closes the line connected to the device.
None
ret ( 0 = OK, 1 = ERROR )

Description: Closes the line that was opened using mexDLComStart (initialization
function).
Be sure to execute this function when terminating the communication.
Example: > ret = mexDLComEnd;
mexDLToolkit;
Function: Displays version information about the software program.
Parameters: None
Return value: None

Example:

> help mexDLToolkit

Model 701991
MATLAB ToolKit for DL Series

Version *.*%*

All Rights Reserved,
Copyright (c) (year) Yokogawa Electric Corporation

IM 701991-61E
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4.2 MEX-Functions for WVF Files

The function names obtained by removing “mex” from the mex function names
correspond to the WVF File Access API functions.

For details on the mex functions, see chapter 3, “File Operation Functions” in the WVF
File Access API User's Manual (IM707712-61E) or chapter 9, “File Operation Functions”
in the WE Control API User's Manual (IM707741-61E).

4.2.1 List of MEX-Functions for WVF Files

Single File Access
mex Function Name Function Page
mexWeDPHeaderReadS Read the header file of the single file. 4-17
mexWeDPDataRead Read the data file of the single file. 4-17
mexWeDPHeaderWriteS Write the header file of the single file. 4-18
mexWeDPDataWrite Write the data file of the single file. 4-18
Sequential File Access
mex Function Name Function Page
mexWeDPHeaderCsReadsS Read the header file of the sequential file. 4-19
mexWeDPCsRead Read the data file of the sequential file. 4-19
mexWeDPHeaderCsWriteS Write the header file of the sequential file. 4-20
mexWeDPCsWrite Write the data file of the sequential file. 4-20

Access to the Specified Item of the Header File

mex Function Name Function Page
mexWeDPHeaderItemRead Read the data of the specified item. 4-21
mexWeDPHeaderItemWrite  Write the data of the specified item. 4-21
Data Operation
mex Function Name Function Page
mexWeDPGetSampleChNum Get the number of samples and number of channels. 4-22
mexWeDPGetBlockNum Get the number of blocks. 4-22
mexWeDPInitializeAcqInfo Store the required data in the data information structure. 4-22
4-16 IM 701991-61E



4.2 MEX-Functions for WVF Files

4.2.2 Single File Access

[ret, ComInfo, Chinfo] = mexWeDPHeaderReadS(filename, blockNo,
ChNum)

Function Read the header file of the single file.
Parameters filename: Name of the file to be read without the extension
blockNo:  Block number to be read (0 origin)

ChNum: Number of channels to be read (number of Chinfo
structures)
Return value ret: Returns 0 if successful. Returns an error code if
unsuccessful.
ComInfo:  Structure of the read information (Cominfo)
ChInfo: Structure of the read information (Chlinfo)

Description ~ Reads the data from the header file by specifying the block number.
Header file of the data acquired using the logic input on the DL
cannot be loaded.

[ret, data] = mexWeDPDataRead(filename, blockNo, ch, dataForm,

dataNum)
Function Read the data file of the single file.
Parameters filename: Name of the file to be read without the extension
blockNo: Number of the block to be read

ch: Number of the channel to be read
dataForm: Type of data to be read
1 =WE_UBYTE

17 = WE_SWORD

33 = WE_SLONG

34 = WE_FLOAT

50 = WE_DOUBLE
dataNum: Number of data points to be read

Return value ret: Returns 0 if successful. Returns an error code if
unsuccessful.
data: Read data

Description ~ Reads the data from the data file by specifying the block number.

Note

The parameter dataNum does not exist in the WE File Access API or the WE Control API
function, but is required in the mex function.
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ret = mexWeDPHeaderWriteS(filename, blockNo, Cominfo, ChNum,
Chinfo, Acqinfo)

Function Write the header file of the single file.
Parameters filename: Name of the file to be written without the extension
blockNo:  Block number to be written (0 origin)

ComInfo:  Structure of the written information (Cominfo)

ChNum: Number of channels to be written (number of Chinfo
structures)
ChInfo: Structure of the written information (Chlnfo)
AcqgInfo: Data information structure to be written
Return value ret: Returns 0 if successful. Returns an error code if
unsuccessful.
Description ~ Writes the header information at once to the header file by specifying
the block.

ret = mexWeDPDataWrite(filename, blockNo, sampleNum, ChNum,

Acqinfo, dataForm, data)
Function Write the data file of the single file.
Parameters filename: Name of the file to be written without the extension
blockNo: Number of the block to be written
sampleNum: Number of samples to be written
ChNum: Number of channels to be written
AcqgInfo: Data information structure to be written

dataForm: Type of data to be written
1=WE_UBYTE
17 = WE_SWORD
33 = WE_SLONG
34 = WE_FLOAT
50 = WE_DOUBLE

data: Data to be written
Return value ret: Returns 0 if successful. Returns an error code if
unsuccessful.

Description ~ Writes the data to the data file in units of blocks.
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4.2.3 Sequential File Access

[ret, ComInfo, Chinfo] = mexWeDPHeaderCsReadS(filename,

seriesNo, ChNum)
Function Read the header file of the sequential file.
Parameters filename: Name of the file to be read without the extension
seriesNo: First sequence number of the file to be read

ChNum: Number of channels to be read (number of Chinfo
structures)
Return value ret: Returns 0 if successful. Returns an error code if
unsuccessful.
ComInfo:  Structure of the read information (Cominfo)
ChInfo: Structure of the read information (Chlinfo)

Description  Collectively reads the header information from a header file.
Header file of the data acquired using the logic input on the DL
cannot be loaded.

[ret, data] = mexWeDPCsRead(filename, seriesNo, start, length, ch,

dataForm, dataNum)
Function Read the data file of the sequential file.
Parameters filename: Name of the file to be read without the extension
seriesNo: First sequence number of the file to be read

start: Start point of the data to be read
length: Number of data points to be read
ch: Number of the channel to be read
dataForm: Type of data to be read

1 =WE_UBYTE

17 = WE_SWORD

33 = WE_SLONG

34 = WE_FLOAT

50 = WE_DOUBLE
dataNum: Number of data points to be read

Return value ret: Returns 0 if successful. Returns an error code if
unsuccessful.
data: Read data

Description ~ Reads the data from the data files (sequential files) by specifying the
number of samples.

Note

The parameter dataNum does not exist in the WE File Access API or the WE Control API
function, but is required in the mex function.
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ret = mexWeDPHeaderCsWriteS(filename, seriesNo, Cominfo,
ChNum, Chinfo, Acqinfo)

Function Write the header file of the sequential file.

Parameters filename: Name of the file to be written without the extension
seriesNo: First sequence number of the file to be written
ComInfo:  Structure of the written information (Cominfo)

ChNum: Number of channels to be written (number of Chinfo
structures)
ChInfo: Structure of the written information (Chlnfo)
AcqgInfo: Data information structure to be written
Return value ret: Returns 0 if successful. Returns an error code if
unsuccessful.

Description  Collectively writes the header information to the header file.

ret = mexWeDPCsWrite(filename, seriesNo, sampleNum, ChNum,

Acqinfo, dataForm, data)
Function Write the data file of the sequential file.
Parameters filename: Name of the file to be written without the extension
seriesNo: First sequence number of the file to be written

sampleNum: Number of samples to be written
ChNum: Number of channels to be written
AcqgInfo: Datainformation structure to be written
dataForm: Type of data to be written

1 =WE_UBYTE

17 = WE_SWORD

33 = WE_SLONG

34 = WE_FLOAT

50 = WE_DOUBLE

data: Data to be written
Return value ret: Returns 0 if successful. Returns an error code if
unsuccessful.

Description ~ Write data to a sequence file.
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4.2.4 Access to the Specified Item of the Header File

[ret, data] = mexWeDPHeaderltemRead(filename, itemName, ch,
blockNo)

Function Read the data of the specified item of the header file.
Parameters filename: Name of the file to be read without the extension
itemName: Name of the item to be read

ch: Number of the channel to be read
blockNo: Number of the block to be read
Return value ret: Returns 0 if successful. Returns an error code if
unsuccessful.
data: Read data

Description  Reads the information of the specified item name and specified
channel from the header information of the header file.

ret = mexWeDPHeaderltemWrite(filename, itemName, ch, blockNo,
data)

Function Write data to the specified item of the header file.
Parameters filename: Name of the file to be written without the extension
itemName: Name of the item to be written

ch: Number of the channel to be written
blockNo: Number of the block to be written
data: Data to be written
Return value ret: Returns 0 if successful. Returns an error code if
unsuccessful.

Description ~ Writes data to the specified item name and specified channel in the
header information of the header file.
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4.2.5 Data Operation

[ret, SampleNum, ChNum] = mexWeDPGetSampleChNum(filename,
blockNo)

Function Get the number of samples and number of channels.
Parameters filename: Name of the file to be read without the extension
blockNo: Number of the block to be read

Return value ret: Returns 0 if successful. Returns an error code if
unsuccessful.
SampleNum: Number of data points read
ChNum: Number of channels read
Description  Gets the number of samples and number of channels of the specified
file.

[ret, blockNum] = mexWeDPGetBlockNum(filename)

Function Get the number of blocks.

Parameters filename: Name of the file to be read without the extension

Return value ret: Returns 0 if successful. Returns an error code if
unsuccessful.

blockNum: Number of block read
Description  Gets the number of blocks of the specified file.

[ret, Acqinfo] = mexWeDPInitializeAcqglnfo(VMaxData, VMinData,

sampleNum, samplnterval, infoNum)
Function Set the data in the data information structure.

Parameters vMaxData: Max data
VMinData: Min data
sampleNum: Number of data samples
sampInterval:Sampling frequency of the data
infoNum: Number of data information structures
Return value ret: Returns 0 if successful. Returns an error code if
unsuccessful.
AcqInfo: Data information structure
Description ~ Stores the required data in the data information structure.
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4.3 MEX-Functions for WDF Files

4.3.1 List of MEX-Functions for WDF Files

Accessing file information

mex Function Name Function Page
mexWdfItemRead Read the file information 4-24
mexWdfGetBlockNum Read the number of blocks 4-24
mexWdfGetChNum Read the number of channels 4-24
Data Operation
meXx Function Name Function Page
mexWdfDataRead Read the raw waveform data 4-25
mexWdfDataReadEx Read the raw waveform data (expanded version) 4-25
mexWdfScaleDataRead Read the physical value waveform data 4-26
mexWdfScaleDataReadEx Read the physical value waveform data (expanded version) 4-26

IM 701991-61E
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4.3 MEX-Functions for WDF Files

4.3.2 Accessing file information

[ret, data] = mexWdfltemRead(filename, itemName, ch, block)
Function Read the file information
Parameters filename: Name of file (with extension) to be read
itemName: Name of item to be read (see Parameters)

ch: Channel numbers to be read (0-)
block: Block numbers to be read (0-)
Return value ret: Returns 0 if successful. Returns an error code if
unsuccessful.
data: Read data

Description  Gets the specified file information (channels, blocks, and items) from
the specified WDF file.

[ret, blockNum] = mexWdfGetBlockNum(filename)

Function Read the number of blocks

Parameters filename: Name of file (with extension) to be read

Return value ret: Returns 0 if successful. Returns an error code if
unsuccessful.

blockNum: Number of blocks read
Description  Gets the number of blocks in the specified WDF file.

[ret, chNum] = mexWdfGetChNum(filename)

Function Read the number of channels
Parameters filename: Name of file (with extension) to be read
Return value ret: Returns 0 if successful. Returns an error code if
unsuccessful.
chNum;: Number of channels read

Description  Gets the number of channels in the specified WDF file.
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4.3.3 Data Operation

[ret, param, data] = mexWdfDataRead(filename, ch, block)

Function
Parameters

Return value

Description

Read the raw waveform data

filename:
ch:
block:

ret:

param:
data:

Name of file (with extension) to be read
Channel numbers to be read (0-)

Block numbers to be read (0-)

Returns 0 if successful. Returns an error code if
unsuccessful.

Structure of the read information (see Structure)
Read data (array)

Gets the specified channel and block data from the specified WDF file.

[ret, param, data] = mexWdfDataReadEx(filename, ch, block,

start,length)

Function
Parameters

Return value

Description

Read the raw waveform data (expanded version)

filename:
ch:
block:
start:
length:

ret:

param:
data:

Name of file (with extension) to be read
Channel numbers to be read (0-)

Block numbers to be read (0-)

Start point of the data to be read

Number of data points to be read

Returns 0 if successful. Returns an error code if
unsuccessful.

Structure of the read information (see Structure)
Read data (array)

Gets a specified range of specified channel and block data from a

specified file.

IM 701991-61E
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4.3 MEX-Functions for WDF Files

[ret, param, data] = mexWdfScaleDataRead(filename, ch, block)

Function
Parameters

Return value

Description

Read the physical value waveform data

filename:
ch:
block:

ret:

param:
data:

Name of file (with extension) to be read
Channel numbers to be read (0-)

Block numbers to be read (0-)

Returns 0 if successful. Returns an error code if
unsuccessful.

Structure of the read information (see Structure)
Read data (array)

Gets the specified channel and physical value block data from the
specified WDF file. Multiply VResolution by the file’s raw data (signed
16-bit integer), and add VOffset.

[ret, param, data] = mexWdfScaleDataReadEx(filename, ch,
block,start, length)

Function
Parameters

Return value

Description

Read the physical value waveform data (expanded version)

filename:
ch:
block:
start:
length:

ret:

param:
data:

Name of file (with extension) to be read
Channel numbers to be read (0-)

Block numbers to be read (0-)

Start point of the data to be read

Number of data points to be read

Returns 0 if successful. Returns an error code if
unsuccessful.

Structure of the read information (see Structure)
Read data (array)

Gets only a specified range of the specified channel and physical
value block data from the specified WDF file. Multiply VResolution by
the file’s raw data (signed 16-bit integer), and add VOffset.
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4.3.4

Parameters and structure

Parameters

Item entered in the itemName area dataType Parameters Meaning

ch  block
Comment string N N Comment string
Version string N N Version string
Model string N N Model name
TraceNumber UINT N N Number of channels
BlockNumber UINT N N Number of blocks
TraceName string Y N Channel name
BlockSize UINT Y Y Block size
VDataType UINT Y Y Data type
VUnit string Y Y Vertical axis unit string
VResolution double Y Y Vertical axis resolution
VOffset double Y Y Vertical axis offset
VScaleUpper double Y Y Vertical axis upper limit scale value
VScaleLower double Y Y Vertical axis lower limit scale value
HResolution double Y Y Horizontal axis resolution
HOffset double Y Y Horizontal axis offset
HUnit string Y Y Horizontal axis unit string
Date string Y Y Date
Time string Y Y Time
DateTime string Y Y Date and Time
VlllegalData double Y Y Loss value
VMaxData double Y Y Maximum value
VMinData double Y Y Minimum value
SplitNumMain UINT N N Main display resolution
SplitNumZz1 UINT N N Zoom-1 display resolution
SplitNumz2 UINT N N Zoom-2 display resolution
TraceColor0 UINT Y N Waveform color (normal)
TraceColor1 UINT Y N Waveform color (neutral)

*Y: Required, N: Ignore
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4.3 MEX-Functions for WDF Files

4.3.5

Structure
Parameters Meaning Value
ch Channels to be read 0-
block Blocks to be read 0-
start Read start point 0-
count Number of points to be read  1-
waveType Output waveform type 0: Measured raw waveforms (AD values)
1: Waveforms converted from physical values
dataType Output waveform data type  0: Unsigned 8-bit integer
1: Signed 8-bit integer
4: 8-bit logical value
16: Unsigned 16-bit integer
17: Signed 16-bit integer
20: 16-bit logical value
32: Unsigned 32-bit integer
33: Signed 32-bit integer
36: 32-bit logical value
48: Unsigned 64-bit integer
49: Signed 64-bit integer
52: 64-bit logical value
34: Single precision real number
50: Double precision real number
256: None
cntOut Number of output points Number of successfully read points
Error Code
Error Code Meaning
0 Concluded successfully
100 File open failed
101 Allocation failed
102 File access error
103 DLL link failed
200 Unsupported version
201 Unsupported format
202 Unknown function
300 Range specification error
301 File handle not found
900 Data obtained when real time measurement failed
901 llegal data values
902 Data that cannot be loaded (PPsave, Z1/Z2save)
1000 Other error
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